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Users

Overview

By default casual visitors are allowed to register themselves on your website to gain access to
additional resources. For example, registered users might be allowed to submit resources or
simulation tools. Your website implements a user registration policy which can be adapted to
suit your particular requirements so you decide what additional resources are made available.
You can disable user registration altogether if you prefer.

Users register themselves on your website using the "Register" link typically found in the upper
right-hand portion of every page (position may vary). Once registered, users will log in to your
website by entering their username and password using the login form found at
http://yourhub.org/login. There are also links on the form to manage users who forget their
usernames or passwords.

See Configuring Registration to learn more about changing registration settings.
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User Manager vs Members Component

User Manager

A legacy go the Joomla! framework that powered previous HUBzero versions, the CMS comes
with a User Manager accessed via the back-end from the "Users" drop-down of the main menu. 

Members Component

HUBzero extended the standard Joomla! user profile with options for more demographic
information (race, sex, etc.) and various other key pieces of information needed for such things
as simulation tools. All this information can be accessed under "Members" in the "Users" list
found in the main menu of the back-end administration. 

When to use which

All user will have an entry in both the User Manager and the Members Component. Any
information edited with one, such as changing a user's name via the User Manager, will also be
automatically reflected in the other. Since the majority of fields in the User Manager are also
represented in the Members Component plus considerably more fields, it is recommended that
all user editing be done in the Members Component. The one exception concerns adjusting a
user's access level (regular user vs. administrator, etc.). This is still done only with the User
Manager. 

Note: The, admittedly, confusing separation of Users and Members should be resolved in a
future version; Functionality from the two components will be merged, providing a single
interface for access user information. 

Managing Members: User Permissions

Users who work closely with the administration of the Hub need to be given access prior to
having these permissions. In order for users to gain these permissions, another Administrator of
the Hub can give other members the same permissions. To give a user Administrator access,
follow these steps:

1. Navigate to the administrative interface of the Hub, also known as the Backend
2. Once there, locate the Users tab and click it to open up a drop-down list
3. Click from the drop-down the User Manager button
4. On the "User Manager: Users" page, click on the name of the user that you wish to give

Administrator access to 
5. Inside the user's account information page, locate the "Assigned Access Groups" box

and click the check box of "Administrator" or the desired group field you want the user to
have permissions to

6. After this step, click on the button "Save & Close" to save the changes you made
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Creating by Proxy

Proxy-creating users

Note: This feature has moved from https://yourhub.org/register/proxycreate to the administrator
backend.

To create an account for another user:

1. In the backend, go to the Members component under the Users menu.
2. Click on the + button to add a new member.
3. Fill in the information about the new user.
4. Click Save & Close and if successful, you will be taken to the user's member backend

information page.
5. At this point, if the hub's setting (found in a plug-in called User - Joomla! under

Extensions>> Plug-in Manager) is set to send email out to newly-created users, the user
will be sent an email about the account and credentials (example below). If email
notification is off, the system will not send an email to the proxy-created user, and it will
be up to you to let them know about their credentials.

From: Your Hub <support@yourhub.org>
Date: Thu, Nov 13, 2014 at 5:01 PM
Subject: New User Details

Hello [NAME HERE],

You have been added as a User to [YOUR HUB] by an Administrator.

This email contains your username and password to log in to https://yo
urhub.org/

Username: [USERNAME HERE]
Password: [PASSWORD HERE]

Please do not respond to this message as it is automatically generated
 and is for information purposes only.
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Editing

Overview

Note: Editing of users is done through the HUBzero Members Manager component, not the
User manager. Any changes made via the Members Manager will also be reflected in the User
tables. Making changes with the User Manager can lead to data becoming out of sync.

1. First login to the administrative back-end.
2. Once logged in, find Components in the main menu bar located toward the top of the

page. You should be presented with a drop-down menu containing a list of all installed
components.

3. Choose Members from the available options.

4. You should now be presented with a list of all the members on your site. There are a
variety of methods to find the specific person you wish to edit: you can search by such
fields as name, email, and ID number. You may also scroll to the bottom of the page and
navigate your way through the entire list. Once found, click the person's name to edit
their information.

5. You may then edit their name, organization, employment status, etc.

6. Once you feel ready to save your changes, scroll back to the top of the page and click 
Save (the icon that looks like a floppy disk) in the upper right portion of the page.

Adjusting Access Level

The CMS offers various levels of access and privileges for users. All new accounts, by default,
will be Registered Users, the access level with the least amount of privileges. Sometimes, you
will need to grant a (trusted) user administrative access so they can manage content and
portions of your hub. We strongly advise that administrative privileges be handed out rarely and
with caution.

To adjust a user's access level:

1. First login to the administrative back-end.

2. Once logged in, go to the User Manager. The User Manager can be found by selecting 
Site > User Manager from the drop-down menu on the back-end of your HUB
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installation.

3. Choose the user you wish to edit from the available list.

4. Once the page has loaded, find the Group option, found on the left-hand portion of the
screen under the User Details grouping.

The available access levels are as follows:

Registered User: Normal visitors who register at the site. Can view Menu Items
that have Access Level of Registered. Cannot edit or submit articles.
Author: Can submit new articles for approval in the front end only. A Publisher
or higher must approve. Cannot edit existing articles.
Editor: Can submit new articles or edit existing articles from the front end only. A
Publisher or higher must approve.
Publisher: Can submit, edit, or publish articles from the front end only.
Manager/Administrator/Super Administrator: Can do all of the above plus can
log into the back end with increasing rights.

5. Select the access level desired for the user and then click Save (the icon that looks like
a floppy disk) in the upper right portion of the page. Changes take affect immediately.
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Deleting

Overview

In order to delete a user from your database, log in to the administration panel and choose 
Site -> User Manager from the top menu. On the opening page, select the checkbox to the left
of the user's name you would like to remove and press the Delete button in the upper-right
corner.
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Looking Up

Overview

There will be times you need to track down a user's information for whatever reason. This can
be a time-consuming task when presented with paging through potentially thousands of
accounts. Luckily, there are multiple ways you can search and narrow down results quickly. 

User Manager

Since information such as user ID, name, username, and email is kept consistent between the
User Manager and Members Component, you can use either one to search for a specific
account.

To search via the User Manager:

1. First login to the administrative back-end.

2. Once logged in, go to the User Manager. The User Manager can be found by selecting 
Site > User Manager from the drop-down menu on the back-end of your HUB
installation.

3. You will be presented with a list of all users registered on your site.

4. Above the list of users are a few options for filtering results.

On the left side is a search box. You can search for users by name, username, or email
address.

On the right side are a few select boxes that allow you to filter the users based on their
access level (editor, administrator, etc.)—here, it's called Group—or log status (logged
in/out).

5. Choose your method for filtering and the list of users will be narrowed down to match
those criteria. Once found, click the person's name to view/edit their information.

 

Note: If you need to find an account to access more information than name, username, and
email, it is recommended to search via the Members component.
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Members Component

From the Administrative Back-end

Since information such as user ID, name, username, and email is kept consistent between the
User Manager and Members Component, you can use either one to search for a specific
account. The Members Component, however, will allow access to more details about a user's
account. The extended demographic information provided by the Members Component, for
example, cannot be accessed via the User Manager.

To search via the Members Component:

1. First login to the administrative back-end.
2. Once logged in, find Components in the main menu bar located toward the top of the

page. You should be presented with a drop-down menu containing a list of all installed
components.

3. Choose Members from the available options.

4. You should now be presented with a list of all the members on your site. There are a
variety of methods to find the specific person you wish to edit: you can search by such
fields as name, email, and ID number.

5. On the left side, above the list of members, is a search field for filtering the list. You can
search by such fields as name, email, and ID number.

6. Choose your method for filtering and the list of users will be narrowed down to match
those criteria. Once found, click the person's name to view/edit their information.
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Default Settings

Private/Public Profiles

By default, new profiles are set to private. This means that only super administrators and the
member him/herself may see and access that profile's information. Private profiles do not
display in search results.

 

Public Profiles by Default

Member profiles may be set to public by default via the administrative Members component. To
do so, log in to the administrative back-end and find Members in the Components list of the
main menu. Once the Members manager page has loaded, locate the Parameters button in the
toolbar (top right, opposite of the Members heading). Click this. You should be presented with a
series of settings. Find Default Privacy and set to Public. All new accounts will now default to
public profiles.

Note: any accounts created before changing this setting will retain whatever configuration they
had. For instance, private profiles will remain private unless manually changed by the user.
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Members

Publishing a Member Plugin

1. Log in to the backend of the Hub and access the Users tab and then click Members.
2. On the Members main page, navigate to the Plugins tab.
3. Select the box beside the plugin that is to be published. This would turn on the plugin

allowing users to access it from their profile page.
4. Click Publish and the plugin will be turned on.

Unpublishing a Member Plugin

1. Log in to the backend of the Hub and access the Users tab and then click Members.
2. On the Members main page, navigate to the Plugins tab.
3. Select the box beside the plugin that is to be unpublished from the Hub. This would turn

off the plugin taking it off their profile page.
4. Click Unpublished and the plugin will be turned off.

Clearing Existing Terms of Use Agreements

When terms of use are changed on the hub, it may be necessary to require users to re-accept
the new terms. To reset all existing agreements, and force re-acceptance, go to the
administrative interface and navigate to the members component. Click the "Reset terms of use
agreements for all users" button, and confirm the action.
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Password Rules

Creating a Password Rule

1. Log in to the backend of the Hub and access the Users tab and navigate to Members.
2. Locate the Password Rules tab in Members.
3. Click New to create a new password rule.
4. Choose the rule that you are going to add more regulations to.
5. Insert the descriptions that define the rule.
6. Insert the failure message if the user fails to meet the correct regulations.
7. Click Save & Close to save the

Deleting a Password Rule

1. Log in to the backend of the Hub and access the Users tab and navigate to Members.
2. Locate the Password Rules tab in Members.
3. Check the rule’s box and then click Delete to delete the rule.
4. The rule will automatically be removed from the Hub.

Editing a Password Rule

1. Log in to the backend of the Hub and access the Users tab and navigate to Members.
2. Locate the Password Rules tab in Members.
3. Check the rule’s box and then click Edit to begin editing the rule.
4. Click Save & Close to save the newly edited material.
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Plugins

Publishing a Member Plugin

1. Log in to the backend of the Hub and access the Users tab and then click Members.
2. On the Members main page, navigate to the Plugins tab.
3. Select the box beside the plugin that is to be published. This would turn on the plugin

allowing users to access it from their profile page.
4. Click Publish and the plugin will be turned on.

Unpublishing a Member Plugin

1. Log in to the backend of the Hub and access the Users tab and then click Members.
2. On the Members main page, navigate to the Plugins tab.
3. Select the box beside the plugin that is to be unpublished from the Hub. This would turn

off the plugin taking it off their profile page.
4. Click Unpublished and the plugin will be turned off.
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Registration

Registration Fields

1. First log in to the administrative backend.
2. Once logged in, find Components in the main menu bar located toward the top of the

page. You should be presented with a drop-down menu containing a list of your installed
components.

3. Choose Registration from the available options.
4. You should now be presented with a table of available user fields and their status for a

particular action. This controls what fields the user will see, must fill in (required) or can
fill in (optional) depending upon which action or state they are currently in. That is, you
can make the username field required for the registration page (“create” column) but
may not wish for your users to be able to edit this after creation (“read only” for the
“update” and “edit” columns).

Create column: What the user sees on the registration page
Proxy column : What columns an administrator sees or must fill in when
creating an account by proxy (i.e., for someone else)
Update column: What fields the user will see and/or must fill in if something has
changed with what information is required at registration. An example of this
would be if the “citizenship” field was, at one point, optional for registration but is
now required. Setting this field to “Required” for the “Update” column will now
require logged-in users to fill this information out.
Edit column: What fields the user will see and can edit for their user profile
Field Option Definitions:  Required = Must fill in Optional = Can fill in Hide =
Not visible Read only = Can view but cannot change

5. Once you feel ready to save your changes, scroll back to the top of the page and click 
Save in the upper right portion of the page. Changes take affect immediately.

Customizing Confirmation Email

All component layouts can be customized through overrides. Except for files that are provided in
the Joomla! distribution itself, this method for customization eliminate the need for designers
and developers to "hack" core files that could change when the site is updated to a new version.
Because they are contained within the template, they can be deployed to the Web site without
having to worry about changes being accidentally

User Authentication Plugins

A Hub can offer multiple ways for users to login through other services like LinkedIn, Facebook,
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ORCID, etc.

Authentication-Certificate: Handles user authentication against client side SSL
certificates
Authentication-Facebook: Handles user authentication against Facebook
Authentication-Google: Handles user authentication against Google
Authentication-Hubzero: Default user authentication
Authentication-LinkedIn: Handles user authentication against LinkedIn
Authentication-ORCID: Handles user authentication against ORCID
Authentication-Picas: Handles user authentication against Purdue's CAS
Authentication-Twitter: Handles user authentication against Twitter

 

To activate these authentication plugins acquire a customer secret and customer key from the
other service by registering your App on the service and selecting the Web format. Once you
have the keys you can enable the plugins from the backend of the Hub. 

1. Navigate to the backend of the Hub and locate the Extensions Tab and click on Plug-in
Manager.

2. Inside of the Plug-in Manager, search for the authentication plugin. 
3. Click on the title of the plugin and inside the plugin insert the customer secret and 

customer key.
4. Change the Status of the plugin to Enabled and then click Save & Close.

TLS Certificate Authentication

Certificate Authentication Plugin:

This plugin is in charge of actually checking the certificate, and creating new accounts or linkingexisting ones to the identity presented in the certificate.  With this plugin on, users can loginusing their certificate credentials.  If a link between those credentials exists, the process iscomplete and the user is logged in.  If a link does not exist, the user is allowed to create a newaccount, thus linking their current certificate to the newly created hub account.  A user can alsoelect to link their current certificate to an existing account, assuming they are able to provide thepassword for that existing account (in the event that someone already has an account on thesystem).  This plugin is called: Authentication - Certificate.

Enable the Authentication - Certificate Plugin:

1. Navigate to the backend of the Hub and locate the Extensions tab.

2. Click on the Extensions tab and from the drop-down click on the Plug-in Manager.
3. Locate from the plugin list or through search the Authentication - Certificate plugin.
4. Click on the title of the plugin then locate the Status section inside the plugin.
5. From the Status drop-down, select Enabled then click Save & Close.

 

Certificate routing plugin:
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This plugin handles the requirement for a certificate to be present while browsing the site.  While
the authentication plugin is what checks and links the user to the cert, other authentication could
still be allowed.  With this plugin enabled, a certificate must be present and authentication
options are limited to just certificate based authentication.  This plugin is called: System -
Certificate.

Enable the System - Certificate plugin by following the same steps listed out above.

 

New account approval:

This allows admins to require approval of new accounts prior to their being able to access the
site.  When this is enabled, accounts pending approval can be found in the users manager on
the backend.  You can also elect to turn on an administrative dashboard module that lists
accounts pending approval.  And in the users manager parameters, you can enable
administrator notifications to receive an email when new accounts are created.  This allows the
certificate->user link to be user initiated (rather than admin initiated), but still gated and admin
approved.

In terms of apache configuration, "SSLVerifyClient optional” should be set.  This will allow the
certificate to be included, but also allow the CMS to handle the requirement for the certificate
through the use of the certificate routing plugin mentioned above.  "SSLOptions +StdEnvVars”
should also be set, as I’m sure it already is for you all.  Lastly, make sure the site is forced to
SSL via the Joomla global configuration on the backend.

 

Note: In order for this feature to be useful, all users need to gain a TLS Certificate and have it
implemented in their browser prior to utilizing this authentication process.
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